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Conteudo da aulo 8

Nesta aula iremos treinar diversos topicos

_ I . Iniciar um novo projeto
de configuracdo dos CLPs Haiwell que S ’ I ,
serdo Uteis no dia-a-dia dos Definicdo da area de memoria retentiva
programadores que estdo acompanhando Criacdo de blocos de programa
O CUrso.

) ) Encriptacdo de projetos
O conteudo desta aula tambéem tem como

objefivo preparar os alunos para ad
avaliacdo on-line para a obtencdo do
certificado de participacdo no
treinamento  CURSO DE AUTOMACAO
UTILIZANDO O CLP HAIWELL.

Para acompanhar esta aula € necessario
ter concluido todas as anteriores.

Criacdo de tabelas de inicializacdo de dados
Adicdo de blocos matemdticos de funcdo
Instrucoes basicas de temporizacdo
Simulacdo do programa

vV vV v vV vV v vV VY

Monitoracdo do reldgio de tempo redl

Siga passo-a-passo a aula 8 para estar
preparado para a avaliacdo.

Veja ao lado os assuntos desta aula.
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Crie um novo projeto 8

» Crie um novo projeto utilizando o modelo T16SOP-e e dé ao mesmo o
nome “Operacdo basica Haiwell”

» Altere a drea de dados retentivos da seguinte forma:
» Operandos V retentivos iniciando em V500 e tamanho de 3000 registros
» Operandos M retentivos iniciando em M 1000 e tamanho de 2000 registros

A janela de criacdo de New Project deve ficar como a seguir
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B3
File Edit View PLC Debug Tcols Windows Help

O & 2-8 7 L: & - B R

~] New project pod

PLC Series: |T Series ~| CPU Type: | T16S0T/P(-e) ~|

Auto save:| 6 < | Minute
T16S0T/P(-e) (VO-V14847 MO-M12287 TO0-T1023 CO0-C255 S0-82047)
CPU module 8*DI 8*DO transistor DC24V power supply 2 channel 200KHz pulse input 2 channel 200KHz
pulse output 2 communication ports support 7 extension modules

Power-off preservation (V500-V3499 M1000-M2999 T96-T127 C64-C127 S156-8255)
Start component Length

V| 500 3000 T 96 < 32 [ A Clear

M| 1000 2000| c[ 64 H 64 13 Default

S| 156 100

Project name: | Operac3o basica Haiwell

User name:l

Designer:[ Version: [

Company:l

Password:l Confirm password: |

Date created:[ 31/01/2018 17:33:30 Modified: |

Comments:

Cancel

[=] Program 2 PLC Offline Currently PLC:None
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Crie blocos de programa 8

» Crie trés blocos de programa principais:
» Bloco 2: 2 Communication
» Bloco 3: 3 High speed
» Bloco 1: 1 Mofor control

» Observe que o0s blocos estdo sendo criados propositalmente fora de
sequéncia

» ApOs criar os frés blocos, reordene 0os mesmos de forma a que o bloco “1
Motor control” seja o primeiro na sequéncia de processamento

alfacomp
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» Cliue em Main Program
para criar os blocos 8

s HaiwellHappy_VZ.ZE?D‘BO& [Untitled]
Ele Edit View PLC Debug Tools Windows Help

D4.0cmt 00, 0o B KBS » Os blocos foram criados na

Project manager 1 x PGB:2 Communication

Jo—" sequéncia abaixo

() HaiwellHappy V2.2,5.180123 [C:\Users\Eduardo\Desktop\2018
File Edit View PLC Debug Tools Windows H
OFO-B? D& &-BRE
Project manager o x

| PLC resources | % Component ., | & Project man... |

Al

aiwell PLC project /
-|:]E| Program
= Main program | i

2C{ @ | New Main program

3 R Import

o | 3

Component use table
ower off preserved data

Hardware configuration

=-f@ Program
. [-4@) Main program

--[E PGB:3High speed

..[Z PGB:1 Motor control
-{@) Sub program
. .jd) Int program
=B Table
. .. Haiwellbus read table
-H8 Haiwellbus write table
F¥ Discrete bittable
Discrete register table
R4
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» Cligue em Debug para
reordenar os blocos 8

11 Program block order %

» Depois de reordenados os

I.;Id:ex Main prnqram Language Move up b | O C O S f| C G m O S Sl m
= O R [ organizados

[ 2 PG E| 2 Communication Maove down
=3 PGB:3 High speed |_[:|

9 HaiwellHappy V2.2.5.180123 [C:\Users\Eduardc\Desktop'2018
File Edit View PLC Debug Tools Windows Hel

O&FSO-HAF 8809 -5

Project manager a x

OK

| & PLC resources | %« Component ... &) Project man... |

=5 5 Operaaro bosica Haiwell ~ |
: E) - Program
©  [=-@@] Main program
. .[Z PGB:1 Motor control
[z PGB:2 Communication
%] PGB:2 High speed
.f@l) Sub program
. . Intprogram
El @ Table
: --H# Haiwellbus read table

Cancel

.8 Haiwellbus write table
. Discrete bit table
2 Discrete register table
4 Reserve 1
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Proteja um bloco com senho 8

» Proteja o bloco de programa “1 Motor control” com a senha “hello”
» Cligue como botdo direito sobre o bloco e selecione Program property

» No campo Password insira a senha e confirme no campo Confirm password

» Salve o projeto, feche o HaiwellHappy, reabra o HaiwellHappy e recarregue
O projeto. Tente abrir o bloco “1 Motor control. Observe que agora a senha
€ exigida

B Main program Project properties X

Block name: | 1 Motar control Password:
Type Language Confirm password:

@LD Comments
(O FBD

(") Sub program Ol

SEC

aT

(® Main program

() Int program

Cancel
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Encriptacdo do projeto 8

» Cligue em Encryption project e intfroduza uma senha.

B8 HaiwellHappy V2.2.5.180123 [C:\Users\Eduardo\Desktop\2018 Haiwell t #= Encryption projet »

File | Edit View PLC Debug Tools Windows Help
[] New project Ctrl+N 5-83 ® = [F] 4
@ New... » 2 x

VProject man...

Y Open project Ctrl+0
|

Recent files >

Confirm password:

|| F Close project
B Save project Ctrl+S
Hj Save project as
Generate PLC executable file

Encryption projet

Cancel

» Observe que depois de infroduzida a senha
de encriptacdo, o programa Y1 Motor
control”, que estd protegido por senhaq,
desaparece do menu. O programa agora
esta escondido. Para o mesmo reaparecer é
necessario desencriptar o projeto.
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Tabela de inicializacao 8

& Initial register table

Start component; () Decimal
Length (010.200)

Component comments

Table name: | Initial table test

Power-off preservation: 1048 Point V1000 - V2047
Component Float (32 bit) Hex
V1200 12.34] 0x414570A4
V1201
V1202

Comments

|

Check code calculator

Curso de automacado utilizando o CLP Haiwell - Aula 8

» Crie uma fabela de
Inicializacdo com o nome
“Iniflal table test” com
endereco inicial V1200 e
tamanho de 30 elementos

» Infroduza V1200 =12.34

» Observe que o valor
Infroduzido  ocupa as
posicoes V1200 e V1201

() Float

Confirm password: |:|

OK Cancel

alfacomp



Tabela de inicializacao 8

i Initial register table 5

” » Selecione hexadecimal
Power-off presenvation: 1048 Point V1000 - V2047 S (010 200) O Charadier > |n'I'rOd UZO V] 202 — ] AQB

Index | Component 16bits value 32bits value Compaonent comments
V1200 T OAL 0 DA4
) 0x1A2B4145
0x00001AZB

Start component (") Decimal (® Hex () Float

Comments

Confirm password: |:|

Check code calculator 0K Cancel
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Tabela de inicializacao

i Initial register table %

Table name:| Initial table test Start component (®) Decimal O Hex () Float

_— . () Character
Power-off preservation: 1048 Point V1000 - V2047 e (010200 -

Component comments

LA B

7
24182
479
0

(R I e I & TR

L & & O
-

ra

14

£n

Comments

Confirm password: l:l

Check code calculator 0K Cancel
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8

» Selecione decimal
» Infroduza V1203 = 32767

» Infroduza V1204
31415926

» Observe que V1205
recebe parte do valor

alfacomp



Tabela de inicializacao 8

& Initial register table 5

» Selecione Character
Table name: | Initial table test Start c:cumpcment: () Decimal () Hex () Float
Power-off presenvation: 1048 Point V1000 - V2047 Length e A Lo mece > | n TrO d U Z O v ] 20 6 — AT /\S MS

Index | Component Character Hex Component comments

ot = 056922230312

v » Com isso vocé aprendeu a
s L criar e preencher uma
T ' tabela de Inicializacdo
com dados nos diversos
formatos numeéricos e na

forma de caractere

Confirm password: |:|

Check code calculator oK Cancel
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Instrucoes matematicas

*PGE:1 Motor control

INetwork 1

Curso de automacado utilizando o CLP Haiwell - Aula 8

8

» Programe as seguintes
operacoes matematicas:

» ADD "V4 =V0 + V2"
» SUB "V10 =V6-V8"
» FMUL "V16 =V12* V14"
» FDIV “V22=VI18 / V20"

alfacomp



Atalhos CTRL+| e CTRL+L 8

IMNetwork 1

» Infroduza uma linha antes da linha

das operagoes matematicas
HNetwoer: Uh“ZOﬂdO CTRL+|

» Introduza uma linha apds a linha das
operacoes matematicas utilizando
CITRL+L

» Uma lista com todas as teclas de
atalho pode ser encontrada no HELP

gg’ Haiwell PLC programming software help

o e & O

Ocultar  Voltar  Imprimir Opgdes

Shortcut key
§uméﬁo| Indice Pesquisar I

HaiwellHappy programming software supply abundant shortcut key, during use
Digite a palavra<chave para localizar:

programming operation easy and efficient ,shortcut key listing as follows:

I Programming operation manual

Category Shortcut key Functio
Listar Tépicos Alt+F Open “File” menu

Alt+E Open "Edit” menu

Alt +V Open "Search” menu

Alt+P Open "PLC" menu

Selecione o Topico para exibigdo:

Hardware manual
Product introduction menu operation
Programming operation manual Alt+D Open "Debug” menu
Quick start Alt+T Open "Tools” menu
IMNetwork 3 Remote module

Simulate and online debugging

Alt+W Open " window” menu

Alt+H Open "Help” menu

I Ctrl +N New program project
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Comparadores e fimer 8

» Infroduza a linha abaixo

/INetwork 3 Testes com reles de comparacao e acionamento do timer

V60 V62 V64
= | HB= | D>= | F=
1234 123456 12,34
|

» Para tanto, na linha Network 3, cligue em serial connect switch no menu superior ou pressione F?
para adicionar o relé. Clique com o botdo direito para selecionar 16-bit comparison switch =,
digite V60 e 1234 respectivamente. Adicione um relé e selecione High Bite compare equal
switch =, digite V61 e 3 respectivamente. Similarmente, adicione o relé 32-bit comparison
switch> =, e um relé floating-point comparison switch < e o valor 12,34, entdo infroduza o

comando SET associado a entrada YO com rising edge.

alfacop
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Comparadores e fimer 8

» Infroduza o comando TON, cligue com o botdo direito e entre na caixa de
configuracAo como abaixo e selecione a base de tempo de 10 ms

3 Instruction: TOMN Delay OM o
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Comparadores e fimer

8

» Cligue na conexdo de entrada com o botdo direito e selecione Negation

para negar o sinal de acionamento do timer

V&1 V&1 VB4
|—| HB.= |—| O== |_| F=
3 123456 1234

Curso de automacado utilizando o CLP Haiwell - Aula 8

Ton command
In terminal

N
_.;;;{
1
=
#
1B
it
X
¥
]

Mormal

Rising edge

Falling edge

Move up Ctrl+U
Move down  Cirl+D
Append

Insert

Replace

Delete

Cut Ctrl+X

Copy Ctrl+C

Find Ctrl+F

Program property




Simulacao do funcionamento 8

» Cligue Emulator start button no menu superior e cligue em V60 para forcar
o valor 1234, similarmente force os valores em Vé1, V62, V64

’ Al Force |ﬁ|

Force
. - =1 .
Component: m

Type: |V

F.

Value: | ®16Bits (O 32Bits
P i T [:Elrl [El
(@ Integer () Float () Character [ ]Hex

» Observe que Y0 ird
ligar quando as
condicoes forem
atendidas

3 decimal = 1000 binary
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Simulacao do funcionamento 8

£ Component state table - Status table1

» Ainda em simulacdo, abra a janela Status
Dcpunent bitalue 32bits value Component comm A Itqble 1 e in.l.roduzo OS VOloreS YO O Y7

¥4 of @

. o @ (digitando YO-7 as 8 primeiras saidas sGo

Y3 of @
Y4 of @

0 e criadas na tabela)
v; g; L

s » Adicione os variaveis de sistema do reldgio
de fempo real SV12 a SV17 (digitando SV12-

ot 17 as é varidveis sdo criadas na tabela)

V7 5

£ > ’ If
Curso de automacado utilizando o CLP Haiwell - Aula 8 _ME



Importacdo de tabela de monitoracao 8

Component state table - Status table2 =N =R

» Importe a tabela de inicializacdo para a tabela de s
A = Status table]l Status table2
m O n I TO ro (; O O Component | 16bits value 32Dbits value Component comm

» Isso ird criar uma nova aba Status Table 2 com os valores R 16709 237"

definidos na tabela que haviamos criado Initial table test

w Component state table - Status table1

Status table1 |

Component | 16bits value 32bits value Component comm 4 - 50
B¢

Y1209 12348 95978706
V1210 14645 842
12850 858
13106
13104
12849

YO Off

Y1 Off

Y2

Y3 off Al Force

Y4 Lock data

Y5

Y6 ;

Y7 V18=0,0
Add table "

Read-only Year v20=0,0

Read-only Month(1

X Delete item

Read-0
BB Howellbusreadtable

H® Haiwellbus write table

B  Discrete bit table

Discrete register table

Hd Reservel >
% Reserve 2 4

=) Reserve3 »

0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
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Rotfina de interrupcdo por tempo 8

» Pare o simulador, delete a linha 1

» Introduza uma nova linha com CTRL+L € configure um fimer 1252 com base de tempo de Tms e
preset de 125

» Adicione a instrucdo ATCH para chamada de sub-rotina acionada pelo timer 71252

M etwork 3

|49
T252 timer reach
Timer interrupt
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Rotfina de interrupcdo por tempo 8

» Cligue no organizador em Int program com o botdo direito e cliqgue em New int program
» Configure o bloco como abaixo
» Estd criado o bloco da rotina por intferrupcdo

IE Int program Project properties x

Type Language Confirm password: |:|

LD Comments
() FBD
(") Sub program (L

(") Main program

(@) Int program SFC
ST

Cancel
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Rotfina de interrupcdo por tempo 8

» Programe a rotina de inferrupcdo de forma a incrementar V1 a cada
vez que for acionada

INT:Timer interrupt

IMetwark 1
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Rotfina de interrupcdo por tempo 8

» No programa principal 1 Motor control, clique duplo na insfrucdo ATCH,
selecione a 149

{# Instruction: ATCH Interrupt binding

[]instruction disable

Component Description
Instruction:ATCH
[49/T252 timer reaches target Interruption 1D

) Interrupt binding
Maone Interruption name

None Enable output [tem IntP: Interruption name

Int program:

Cancel

Curso de automacado utilizando o CLP Haiwell - Aula 8 Qlcho E



Rotfina de interrupcdo por tempo 8

» Intfroduza o relé normalmente fechado 7252 no inicio da linha para que
o fimer 252 seja resetado a cada 125 ms

/MNetwork 3

T252
/

149
T252 timer reach
Timer interrupt
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Rotfina de interrupcdo por tempo 8

» Enfre no simulador e observe que o timer € reiniciado a cada 125 ms quando o relé 17252 pulsa
» A cada reinicializacdo a rofina de interrupcdo € acionada

IMNetwork 3

T252
F

149
T252 timer reach
Timer interrupt

» Observe que o valor de V1 na rotina de inferrupcdo € incrementado a cada
vez que a rofina € acionadad

/MNetwork 1
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Sub-rotfino 8

» Vamos agora criar uma sub-rotina para calcular a hipotenusa de um tridngulo
retdngulo, dados dois catetos ( a2 = b%2 + ¢2? ), Teorema de Pitagoras

B Sub program Project properties > |

» Cligue em subroutine no
Type = Language Cr:|r|ﬂrmpa-3-5wcwdil:| menu |GTerO|/ GbrCI G

P (@ LD Comments
() Main program

janela de configuragao
I\; I:r: Fllrzr;rir:-lm : !:_FI: :l e d é O nome ”The
Pythagorean Theo",

Parameters (Input Max.=8 Qutput Max.=3)

BcEEnnent E:[] name :Zr:]ar.tl.-'pe :Zrij-a_;aty'pe Camments Clique Append e
L ouT adicione LVO e LV1 (INT)
e LV2 (REAL) como ao

lado

Cancel
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Sub-rotfino 8

SUB:The Pythagorean theo (L. *PGE:1 Motar contral

» Infroduza as instrucoes ITOF,
FXY, FADD e FSQR na sub-
rotina como ao lado

Curso de automagdo uftilizando o CLP Haiwell - Aula 8 Qlcho E



Sub-rotfino 8

» No programa 1 Motor Control crie a chamada da sub-rotina com a instrucdo CALL

= — » Introduza as variaveis
e — V32 e V34 como entradas
ltem Component G ) e V36 Como Saldas

Input Instruction:CALL
SubP Nape Call subroutine

» Entre em modo

L ltem SubP: Subroutine name

S simulacéo e atribua

Sub program:

ouT V36 The Pythagorean theo ValOreS a. V32 e V34

» Visualize a hipotenusa
calculada em V36

Cancel

/Metwork 4

CALL
En Enao

The Pythagorean theao subP  OUT W36=5.0

alfacomp
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Monitor grafico de tendéncia 8

» Monitore a variavel inferna SV17 (segundos) do reldgio de tempo real e observe
a evolucdo do valor

» Inicie o simulador e cligue em Trend monitor e digite SV1/ no primeiro campo

» Altere o Upper limit para 60 e observe a evolucdo grafica do contador de
segundos

Trend monitor

i) Message window 4 Trend monitor 2 The table of lock data (0) ﬁE Hardware simulation windows _ Simulation status 2017/12/25 10:29:30

Component Value Lowerlimit ~ Upper limit 32Bits Float Minute []Pause
A8 ] o O

O]

B

o]

B ]

o |

O]

O]

o]

vJ Simulation & PLC Offline Currently PLC:Nane 77 Seantime1.0 ms f= Networks: 1of3
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Aula 8 — Assuntos apresentados 8

O conteudo desta aula teve como objetivo
preparar os alunos para a avaliacdo on-line
para a obtencdo do cerfificado de
participacdo no freinamento CURSO DE

Para acompanhar esta aula € necessario ter Criacdo de tabelas de inicializacdo de
concluido todas as anferiores. dados

Siga  passo-a-passo a aula 8 para estar
preparado para a avaliacao.

Veja ao lado os assuntos desta aula.

Iniciar um novo projeto
Definicdo da area de memoaria retentiva
Criacdo de blocos de programa

vV vvyyvVvyy

Adicdo de blocos matemdticos de funcdo
Instrucoes bdsicas de temporizacdo
Simulacdo do programa

Monitoracdo do reldgio de tempo real

v vywyy

OBRIGADO POR ACOMPANHAR NOSSO CURSO!
VISITE NOSSO SITE E FACA O DOWNLOAD DOS MANUAIS E SOFTWARES.

A VERSAO PDF DESTA AULA PODE SER ENCONTRADA NO SEGUINTE LINK:
HTTP://WWW.ALFACOMP.IND.BR/PROGRAMACAO-HAIWELL-PROD-81.HTML
ATE A PROXIMA AULA

www.alfacomp.ind.br QIFQCOM
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